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Document History

1 Note
Before you start the implementation, make sure you have the latest version of this document that is
available at http://service.sap.com/instguides .

The following table provides an overview on the most important document changes:
Table 1:
Date

Version Description

2.3 2017-02-06 Updated version for software provi-
sioning manager 1.0 SP19 (SL Toolset
1.0 SP19)

2.2 2016-10-07 Updated version for software provi-
sioning manager 1.0 SP18 (SL Toolset
1.0 SP18)

2.1 2016-06-06 Updated version for software provi-
sioning manager 1.0 SP17 (SL Toolset
1.0 SP17)

20 2016-02-15 Updated version for software provi-
sioning manager 1.0 SP10 (SL Toolset
1.0 SP16)

19 2015-10-12 Updated version for software provi-
sioning manager 1.0 SPO9 (SL Toolset
1.0 SP15)

18 2015-09-14 Updated version for software provi-
sioning manager 1.0 SPO9 (SL Toolset
1.0 SP14)

17 2015-04-27 Updated version for software provi-
sioning manager 1.0 SPO8 (SL Toolset
1.0 SP13)

16 2014-11-24 Updated version for software provi-
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1.0 SP12)

15 2014-07-07 Updated version for software provi-
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1.0 SP11)
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1 Introduction

11 About this Document

This installation guide describes how to install a standalone Gateway for SAP systems based on SAP
NetWeaver using the installation tool software provisioning manager 1.0 SP19 (“installer” for short), which is
part of SL Toolset 1.0 SP19.

You can find a complete list of supported SAP system products in SAP Note 1680045 .

Each instance of an SAP system with AS ABAP has a Gateway. The Gateway enables communication between
work processes and external programs, as well as communication between work processes from different
instances of SAP systems.

With a standalone Gateway, you can install the Gateway service separately from the SAP system. In this case,
the SAP system can access each external Gateway under a different Remote Function Call (RFC) connection.

1 Note

There is no difference between a standalone Gateway instance for a Unicode system and a standalone
Gateway for a non-Unicode system.

1.2 About Software Provisioning Manager

Software Provisioning Manager 1.0 is the successor of the product- and release-specific delivery of
provisioning tools, such as SAPinst. Before you run it, we recommend that you always download the latest
version of Software Provisioning Manager 1.0. Software Provisioning Manager 1.0 is part of the Software
Logistics Toolset 1.0 (“SL Toolset” for short). This way, you automatically get the latest fixes and supported
processes. For more information about Software Provisioning Manager as well as products and releases
supported by it, see SAP Note 1680045 and http://scn.sap.com/docs/DOC-30236¢% . “SAPinst” has
therefore been renamed to “Software Provisioning Manager 1.0" in this documentation. However, the term
“SAPinst” is still used in:

e Texts and screen elements in the Software Provisioning Manager GUI
e Naming of executables, for example sapinst.exe

In the following, we generally refer to Software Provisioning Manager 1.0 as the “installer”. We only use the
term “Software Provisioning Manager 1.0" if this is required for technical reasons.

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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° Caution

SAP is going to restrict maintenance for operating system versions that have been initially released with
SAP kernel 7.2<x> but are no longer supported for SAP kernel 7.40 and higher. The following Software
Provisioning Manager operating system versions are affected:

o WINDOWS SERVER ON IA32 32BIT
o WINDOWS ON |A64
o WINDOWS ON X86_64 64BIT: < 6.0 aka Windows 2008

With the release of Software Provisioning Manager 1.0 SPS 18, the 70swWPM* . SAR archive will stop
working on the above listed outdated operating system versions.

Instead of using the 70swpM* . SAR archive, you must use the RMOS70SWPM* . SAR archive for these
outdated operating system versions.

Keep in mind that the RMOS70swPM* . SAR archive will not receive improvements in the future. SAP
maintenance for RMOS70sWPM* . SAR will be finally stopped by the end of 2017.

SAP recommends upgrading the operating system to a more recent version and using
RMOS70SWPM* . SAR to export from existing SAP systems.

Related Information

Preparing the Installation Media [page 22]

1.3 SAP Notes for the Installation

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most
recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note which you can find in the SAP Service
Marketplace at http://service.sap.com/notes/.

Table 2: SAP Notes for the Installation

SAP Note Number Title Description
1680045 P Release Note for Software Provisioning Software provisioning manager 1.0 with
Manager 1.0 installation and system copy for SAP
NetWeaver-based systems
1760513/ Inst. Standalone Gateway for SAP Sys- Additional Information about standalone
tems Based on SAP NetWeaver 7.0 incl. Gateway installation.
EHPs

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
NetWeaver 7.0 to 7.03 onWindows
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1.4 Accessing the SAP Library

The references to SAP NetWeaver Library documentation in this installation guide always refer to the
following on SAP Help Portal:

Table 3:

Product and Release ‘ SAP Library Path

SAP systems based on SAP NetWeaver 7.3 http://help.sap.com/nw73|[F Application Help # Function-Oriented View:

English 3

SAP systems based on SAP NetWeaver 7.3 in-
cluding Enhancement Package 1

http://help.sap.com/nw731|} Application Help > Function-Oriented
View: English |

SAP systems based on SAP NetWeaver 7.4 http://help.sap.com/nw74|} Application Help > Function-Oriented View:

English 4

SAP systems based on SAP NetWeaver 7.5 http://help.sap.com/nw75|} Application Help » Function-Oriented View:

English }

1.5 Naming Conventions

In this documentation, the following naming conventions apply:

1 Note

From a technical point of view, the standalone Gateway is set up like an SAP system with its own SAP
system ID (SAPSID), its own operating system users, and its own directory structure.

e nstaller refers to software provisioning manager 1.0.
e SAP system refers to standalone gateway.
e nstance refers to astandalone gateway instance.

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
NetWeaver 7.0 to 7.03 onWindows
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2 Planning

2.1 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the
Gateway instance.

Caution

If your hosts do not fully meet the requirements, you might experience problems when working with the
SAP system.

Process Flow

1. Check the Product Availability Matrix at http://service.sap.com/pam# for supported operating system
releases.

2. If you want to use the standalone Gateway for a production system, the values provided by the
Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In
addition, do the following:

o You use the hardware sizing information available at http://service.sap.com/sizingfr.
o You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing
depending on:
o The set of applications to be deployed
o How intensively the applications are to be used
©  The number of users

2.1.1 Hardware and Software Requirements Tables
Use

The Gateway host must meet at least the following requirements for the Gateway instance:

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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Table 5: Hardware Requirements

Hardware Require-

ment

Minimum disk space

Requirement

e 1GB of hard disk space minimum for
the installation as such.

e Temporary disk space for every re-
quired installation medium that you
have to copy to a local hard disk:
4.3GB

How to Check

To check disk space:

e Windows Server 2012 (R2):

1. Open PowerShell in elevated mode, and
enter the following command:
get-volume

2. Check the value SizeRemaining of the
disk you want to install on.

e Windows Server 2008 (R2):

1. Choose |} Start > All Programs >
Administrative Tools > Storage >
Computer Management > Disk

Management 3.
2. Right-click the drive and choose
Properties.

Minimum RAM

The standalone gateway instance requires 1
GB RAM minimum.

To check RAM:
e Windows Server 2012 (R2):

Open PowerShell in elevated mode, and enter
the following command:
Get-WmiObject
Win32_ ComputerSystem
e Windows Server 2008 (R2):

Choose [+ Start  Control Panel  System 4.

1 Note

If System is not visible, change View by:
from Category into Large icons.

10 CUSTOMER
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Hardware Require- Requirement How to Check

ment

Paging file size For more information, see SAP Note To check paging file size:
1518419#% . e Windows Server 2012 (R2):

For more information, see Checking and
Changing the Paging File Settings on Windows
Server 2012 (R2) [page 40]

e Windows Server 2008 (R2):
1. Choose |} Start > Control Panel >
System ]

1 Note

If System is not visible, change View
by: from Category into Large icons.

Choose Advanced system settings.
In section Performance, select
|} Settings... > Advanced }

4. |Ifrequired, in section Virtual memory,
choose Change.

1 Note

Do not select Automatically managed
paging file size for all drives.

Processing units The number of physical or virtual process- -
ing units usable by the operating system im-
age must be equal to or greater than 2.

One physical or virtual processing unit usa-
ble by the operating system image might be
sufficient.

Examples of processing units are processor
cores or hardware threads (multithreading).

In a virtualized environment, ensure that ad-
equate processor resources are available to
support the workloads of the running SAP
systems.

Suitable backup sys- - -
tem

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
NetWeaver 7.0 to 7.03 onWindows
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Table 6: Software Requirements

Software Requirement | Requirement How to Check

Windows operating sys- | ® 64-bit version of one of the following Win- | To check your Windows version:

tem dows Server Editions of a supported Win- e Windows Server 2012 (R2):

d ti tem:
ows operating system Open PowerShell in elevated mode, and

©  Windows Server 2012 (R2): enter the following command:

o Windows Server Standard Edition Get-WmiObject
©  Windows Server Datacenter Edi- Win32 OperatingSystem |
tion N

select caption

6 o Windows Server Standard Edition Windows Server 2008 (R2):
o Windows Server Enterprise Edi-

tion 1. Choose | Start » All Programs

o Windows Server Datacenter Edi- Accessories  Command Prompt

tion 2. Enter the command winver

o Windows Server 2008 (R2) for Ita-
nium-Based Systems Edition

Caution

Make sure that you install the English
language pack so that your support re-
quests can be handled quickly.

e Forany version of Windows Server, you
need the latest supported service pack

Windows regional set- English (United States) must be set by default. Choose |} Start > Control Panel > Clock
tings For more information about localized Windows

Language, and Region » Language ..
versions, see SAP Note 362379 . suag gion  Language 1

You can install additional languages but the de-
fault setting for new users must always be
English (United States).

2.2 Basic Installation Parameters

The tables below list the basic system parameters that you need to determine before you start the installation.
For all other SAP system parameters, use the F1 help in the installer screens.

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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Table 7:

Parameters

SAP System ID <SAPSID>

Description

The SAP System ID <saps1D> identifies the whole SAP system.

Caution

Choose your SAP system ID carefully. You cannot change the SAP system ID
after the installation.

Make sure that your SAP system ID:

e (Consists of exactly three alphanumeric characters
e (Contains only uppercase letters
® Has aletter for the first character

e Does not include any of the reserved IDs listed in SAP Note 1979280 #% .

Caution

You must choose an SAP system ID that is different from the SAP system ID
of the central instance of the SAP system for which you want to use the
standalone Gateway.

Instance Number

Instance Number:

Technical identifier for internal processes. Consists of a two-digit number from
00 to 98. The instance number must be unique on a host. That is, if more than
one SAP instance is running on the same host, these instances must be as-
signed different numbers.

Caution

Do not use 43, 89 for the instance number because:

e 43isusedby MSCS

e 89is used by Windows Terminal Server

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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Parameters

Operating System (OS) Users

Description

The installer will create the following operating system users:

e |fyou perform alocal installation
o SAP system administrator:
<Host Name>\<sapsid>adm
o SAP service user:
<Host Name>\SAPService<sapsid>
e |f you perform a domain installation
o SAP system administrator:
<Domain Name>\<sapsid>adm
o SAP service user:

<Domain Name>\SAPService<sapsid>

The installer prompts you to assign a password during the input phase of the in-

stallation.

14 CUSTOMER
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3 Preparation

3.1 Checking the Windows File System

Use

1 Note

You must use NTFS for an SAP system installation. Do not install the SAP directories on a FAT partition.

Procedure

1. Open the Windows Explorer.
2. Select the relevant disk.

3. Choose|» Properties » General .
The system displays the type of file system in use.
4. Check that the file system is NTFS.

3.2 Reducing the Size of the File Cache

Use

1 Note

This step is not required if you use Windows Server 2008.

The Windows file cache directly competes with SAP programs for memory. Therefore, you should adjust the
file cache as described below.

Procedure

1. Choose |} Start » Control Panel » Network Connections  Local Area Connections 3.

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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2. Inthe Local Area Connection Status dialog box, choose Properties.

3. Inthe Local Area Connection Properties dialog box, double-click File and Printer Sharing for Microsoft
Networks.

4. Select Maximize data throughput for network applications.

Caution

If you cannot select File and Printer Sharing for Microsoft Networks, this option has not yet been
installed. To install it, you need the Windows Server CDs.

5. To confirm your entries, choose OK.

3.3 Required User Authorization for Running the Installer

Use

Although the installer automatically grants the required rights to the user account used for the installation, you
have to check whether this account has the required authorization to perform the installation. The
authorization required depends on whether you intend to perform a domain or local installation. If necessary,
you have to ask the system administrator to grant the account the necessary authorization before you start
the installation. If you attempt the installation with an account that has not the required authorization, the
installation aborts.

This section informs you about the authorization required for a domain and a local installation.

Procedure

Caution

Do not use the user <sapsid>adm for the installation of the SAP system.

Domain Installation

For a domain installation the account used for the installation needs to be a member of the local
Administrators andthe domain Admins group of the domain involved. All machines in the system must
belong to the same domain. In a domain installation, the user information is stored centrally on the domain
controller and can be accessed by all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to
perform a domain installation to avoid authorization problems.

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.

2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of
the domain Admins group.

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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Local Installation

For a local installation the account used for the installation needs to be a member of the local
Administrators group of the machine involved. In a local installation, all Windows account information is
stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

Caution

Do not use the Windows built-in account Administrator or the renamed built-in account to install your
SAP system with the installer. The built-in account only has restricted network access rights that are
required by the installer. If you renamed the built-in account Administrator, do not create a new account
named Administrator.

For alocal installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.

2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of
the local Administrators group.

3.4 Performing a Domain Installation Without Being a
Domain Administrator

Use

You normally perform a domain installation of the SAP system with a user who is a member of the domain
Admins group, as described in Required User Authorization for Running the Installer [page 16]. If for any
reason, the account used for the installation is not a member of the domain Admins group, you can perform
the installation with a domain user who is a member of the local Administrators group. In this case, the
domain administrator has to prepare the system appropriately for you. The domain administrator can perform
the following steps either using the installer or manually:

1. Create the new global group SAP_<SAPSID> GlobalAdmin.

2. Create the two new SAP system users <sapsid>admand SAPService<SAPSID>.

3. Addthe users <sapsid>admand SAPService<SAPSID> to the newly created group
SAP_<SAPSID> GlobalAdmin.

1 Note

The installer creates the operating system user for the SAP Host Agent by default as a local user that is not
a member of the local Administrators group. If you want to create this user manually as a domain user,
you must perform the following steps:

1. Create the new global group SAP_SAP GlobalAdmin.

2. Create the SAP system user sapadm.

3. Add the user sapadmto the newly created group SAP_SAP GlobalAdmin.

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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However, for security reasons we strongly recommend you to create this users as a local user.

Prerequisites

® You must be domain administrator to perform the required steps.

e Windows Server 2008 (R2) and Windows Server 2012 (R2):
You must have installed the feature Remote Server Administration Tools as follows:

o Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
add-windowsfeature RSAT-ADDS

o Windows Server 2008 (R2):

1. Chooselp Start » Administrative Tools ¥ Server Manager 3.
2. Inthe Server Manager window, select Features.

3. Select the feature [ Remote Server Administration Tools ¥ Role Administration Tools ¥ Active

Directory Domain Services Tools 3.

Procedure

Creating the Required Users and Groups Using the Installer

On the host where the SAP system is to be installed, the domain administrator runs the installer [page 27],
and chooses | <Product> » Software Life-Cycle Options » Additional Preparation Options j» Operating

System Users and Groups 4 to have the group and users created automatically.

Creating the Required Users and Groups Manually

1 Note

To create the users and groups specific to the SAP Host Agent, you must follow the procedure below, and
replace the users and groups with those for the SAP Host Agent.

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin

Perform the following steps:

e Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
net group SAP_<SAPSID> GlobalAdmin /add /domain

e \Windows Server 2008 (R2):
1. Logonas domain administrator.
2. Start the Active Directory Users and Computers Console by choosing:

| Start » Control Panel » Administrative Tools  Active Directory Users and Computers 3.

3. Right-click Users in Tree, and choose |» New » Group 3.

4. Enter the following:
Group name: SAP_<SAPSID> GlobalAdmin

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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5. Select the following:
1. Group scope: Global
2. Group type: Security
6. Choose OK.

Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>

Perform the following steps:

e Windows Server 2012 (R2):
1. Open PowerShell in elevated mode.

2. Create the <sapsid>adm user with the following command:
net user sapsid>adm <password> /add /domain

3. Create the sapservice<SAPSID> user with the following command:
net user SAPService<SAPSID> <password> /add /domain

e Windows Server 2008 (R2):
1. InActive Directory Users and Computers Console, right-click Users in Tree and choose:
I New » User 3
2. Enter the following:

Table 8:
Field Input for <sapsid>adm Input for SAPService<SAPSID>
First name: None None
Initials: None None
Last name: None None

3. Choose Next and enter the following:
Password: <password>
Confirm password: <password>

4. Select Password never expires.
1 Note

Make sure that no other options are selected.
5. Choose | Next ¥ Finish 1.

Adding the Manually Created Users to Groups

1 Note

To add the users specific to the SAP Host Agent to the relevant groups, you must follow the procedure
below, and replace the users and groups with those for the SAP Host Agent.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

e Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
net group SAP_<SAPSID> GlobalAdmin <sapsid>adm /add /domain

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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e Windows Server 2008 (R2):
1. Inthe Users folder, double-click the newly created user account <sapsid>admin the list on the right.

2. Choose | Member » Add 3.
3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.

1 Note

By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

e Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
net group SAP_<SAPSID> GlobalAdmin SAPService<SAPSID> /add /domain

e Windows Server 2008 (R2):
1. Inthe Users folder, double-click the newly created user account SAPService<SAPSID> in the list on
the right.
Choose | Member  Add 3.
Select the new SAP_<SAPSID>_GlobalAdmin group.
Choose Add to add it to the list, and then OK.
Choose OK to close SAPService<SAPSID>Properties.
Close the Active Directory Users and Computers Management Console.

o oA WD

3.5 SAP Directories

The installer automatically creates the directories listed in the following figures and tables.
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Busr
Gsap
BG<SAPSID>
E<INSTANCE>

Hlog

Hdata Rev:

Bwork <INSTANCE> Instance Name
£ISYS nuc non-unicode

=global uc unicode

Sprofile

Oexe

GInuc or uc

O<platform>

Figure 1:

The instance hame (<INSTANCE>) of the Gateway instance is G<Instance Number>, for example G0O0.

SAP Directories in Detail

1 Note

The listed space requirements are initial SAP requirements.

Depending on your operating system, you might also have to add space for administrative purposes.

Table O:

Directory Name Description Space Required
<Drive>:\usr\sap The system will be installed under <Drive>:\usr 400 MB
\<SAPSID> \sap\<SAPSID>.

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
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3.6 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide
their physical network identities from each other. This can be useful when quickly moving SAP servers or
complete server landscapes to alternative hardware without having to reinstall or reconfigure.

Prerequisites

e Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

e Make sure that you configured the Windows operating system properly to use virtual host names. For
more information, see SAP Note 1564275 .

Procedure

To install a non-high-availability system using virtual host names, proceed as described in SAP Note 1564275
i

3.7 Preparing the Installation Media

This section describes how to prepare the installation media.
Installation media are available as follows:

e The Software Provisioning Manager 1.0 archive containing the installer.
You always have to download the latest version of the Software Provisioning Manager 1.0 archive.

e The media containing the software to be installed, which are available as follows:
o You normally obtain the physical installation media as part of the installation package.

©  You can also download the installation media apart from the Software Provisioning Manager 1.0
archive from SAP Service Marketplace, as described at the end of this section.

Related Information

Downloading the Software Provisioning Manager Archive [page 23]
Downloading Installation Media [page 25]
Using the Physical Media from the Installation Package [page 24]
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3.7.1 Downloading the Software Provisioning Manager
Archive

You always have to download and unpack the Software Provisioning Manager 1.0 archive
(70SWPM10SP<Support Package Number> <Version Number>.SAR)from the SAP Software Download
Center because you must use the latest version.

Prerequisites

Make sure the latest version of the SAPCAR archiving tool is available on each installation host.

You require the SAPCAR archiving tool to be able to unpack software component archives (¥.SAR files), which
is the format of software lifecycle media and tools that you can download from the SAP Software Download
Center.

If required, you can download the latest version of SAPCAR from:
http://support.sap.com/swdcf | Software Downloads » SUPPORT PACKAGES & PATCHES » By
Alphabetical Index (A-Z) » S » SAPCAR 1.

For more information about SAPCAR, see SAP Note 212876 .

Procedure

1. Download the latest version of the Software Provisioning Manager 1.0 archive
70SWPM10SP<Support Package Number> <Version Number>.SAR from:

http://support.sap.com/swdc# | Software Downloads » SUPPORT PACKAGES & PATCHES » By
Alphabetical Index (A-Z) ¥ S » SOFTWARE PROVISIONING MANAGER 3

1 Note

If you have an operating system version that has been initially released with SAP kernel 7.2<x> but is no
longer supported for SAP kernel 7.21 or 7.22, instead of the 70swpM* . SAR archive you must download
the RMOS70SWPM* . SAR archive for these outdated operating system versions. For more information,
see About Software Provisioning Manager [page 6].

2. If you want to verify the signature of the
70SWPM10SP<Support Package Number> <Version Number>.SAR archive, execute the following
commands :

1 Note
In addition, check SAP Note 1680045#% whether additional information is available.

<Path to SAPCAR>\sapcar.exe -tVvf<Path to Temporary Directory>
\70SWPM10SP<Support Package Number> <Version Number>.SAR

Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
NetWeaver 7.0 to 7.03 onWindows
Preparation CUSTOMER 23


http://help.sap.com/disclaimer?site=http://support.sap.com/swdc
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/212876
http://help.sap.com/disclaimer?site=http://support.sap.com/swdc
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1680045

3. Unpack the Software Provisioning Manager archive to a local directory using the following command:

<Path to SAPCAR>\sapcar.exe -xvf <Path to Temporary Directory>
\70SWPM10SP<Support Package Number> <Version Number>.SAR

1 Note

Make sure that all users have read permissions for the directory where you want to unpack the installer.

Caution

Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not
unpack it to the same folder as other installation media.

3.7.2 Using the Physical Media from the Installation Package

This section describes how you use the physical installation media as part of the installation package.

Procedure

1. Identify the required media for your installation as listed below.

1 Note

For more information about which kernel version to use, see SAP Note 1680045#% . In addition, check
the Product Availability Matrix at http://support.sap.com/pam

The following table shows the media required for the installation of a standalone Gateway instance:

Table 10:
Installation Media Description
Software Provisioning Manager 1.0 Software provisioning manager 1.0 archive
70SWPM10SP<Support Package Number> <Version Number>.
SAR
SAP Kernel Non-Unicode (NUC) Kernel (folder K_<vVersion> N <0S>)where N

means “non-Unicode”.

2. Make the installation media available on the installation host as follows:
a. Download and unpack the latest version of Software Provisioning Manager as described in
Downloading the Software Provisioning Manager Archive [page 23].
b. Make the installation media containing the software to be installed available.
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Caution

o |If you copy the media to disk, make sure that the paths to the destination location of the copied
media do not contain any blanks and commas.

o |f you perform a domain installation and do not want to copy the media but use network drives
for mapping the installation media, make sure that the <sapsid>adm user has access to the
UNC paths of the network drives.

3.7.3 Downloading Installation Media

This section describes how you download installation media from the SAP Software Download Center.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading
the Software Provisioning Manager Archive [page 23].

2. Create a download directory on the host on which you want to run the installer.

3. ldentify all download objects that belong to one installation medium according to the following criteria:

1 Note

Installation media might be split into several files. In this case, you have to reassemble the required files
after the download.

o Download path or location:
You can download installation media from the SAP Software Download Center using one of the
following paths:
o http://support.sap.com/swdc | » Software Downloads ¥ Installations & Upgrades j By
Alphabetical Index (A-Z) » <First Letter Of Product> » <Product Version> 4

o http://support.sap.com/swdct|r » Software Downloads » Installations & Upgrades » By
Category » <Product> # <Product Version> §

o For downloading the kernel media, proceed as described in the Kernel Media section of SAP Note
1680045¢% .

o Material number

All download objects that are part of an installation medium have the same material number and an

individual sequence number:

<Material Number> <Sequence Number>

Example
51031387 1
51031387 _2
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o Title
All objects that are part of a medium have the same title, such as <solution><Media Name><0S> or
<Database>RDBMS<0S> for RDBMS media.

4. Download the objects to the download directory.
5. To correctly recombine the media that are split into small parts, unpack all parts into the same directory.

In the unpacking directory, the system creates a subdirectory with a short text describing the medium and
copies the data into it. The data is now all in the correct directory, the same as on the medium that was
physically produced. For more information, see SAP Note 1258173 # .

Caution

Make sure that you unpack each installation media to a separate folder. Do not unpack installation
media to the same folder were you unpack the Software Provisioning Manager archive.

Related Information

Downloading Installation Media [page 25]
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4 Installation

4.1 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer:

e Make sure that you use an account with the required user authorization to run the installer [page 16].
e Make sure that you have specified the most important SAP system parameters as described in Basic SAP
System Installation Parameters [page 12] before you start the installation.
® Make sure that the following ports are not used by other processes:
o Port 21212 is used by default for communication between the installer GUI server and the installer GUI
client.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the
following command line parameter:
SAPINST DIALOG_PORT=<Port Number>
o Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer
processing.
The filled-out evaluation form is then sent to SAP using HTTPS.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the

following command line parameter:
SAPINST HTTP_ PORT=<Port Number>

4.2 Running the Installer

This section describes how to run the installation tool Software Provisioning Manager 1.0 (the “installer” for
short).

Software Provisioning Manager 1.0 includes a GUI client and a GUI server, which both use Java. In the
following, GUI client and GUI server are called the “installer GUI". For more information about the installer, see
Useful Information About the Installer [page 29].

This procedure describes an installation where the installer and the installer GUI are running on the same host.

Prerequisites

For more information, see Prerequisites for Running the Installer [page 27].
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Procedure

4.

28

Log on to the installation host using an account with the required user authorization to run the installer
[page 16].

Caution
Do not use an existing <sapsid>adm user.

Make the installation media available on the installation host.
For more information, see Preparing the Installation Media [page 22].

. Start the installer by double-clicking sapinst .exe from the directory to which you unpacked the

Software Provisioning Manager archive.
The GUI starts automatically by displaying the Welcome screen.
1 Note

If you want to use a virtual host name, open a command prompt or PowerShell window in elevated
mode and change to the directory to which you unpacked the Software Provisioning Manager archive .

Start the installer with the following command:
sapinst.exe SAPINST USE HOSTNAME=<Virtual Host_Name> (in a command prompt)
.\sapinst.exe SAPINST USE_ HOSTNAME=<Virtual Host_Name> (in PowerShell)
For more information, see Using Virtual Host Names [page 22].
On the Welcome screen, choose the following options in the following sequence:

o Toinstall a new standalone Gateway instance, go to | <Product> 4and choose: | Standalone

Engines » Gateway J

o Torename an existing standalone Gateway instance, go to System Rename and choose: | Distributed

System  System Rename for Gateway Instance 3

o To uninstall an existing standalone Gateway instance, go to |F <Product> » Software Life-Cycle
Options ¥ Uninstall 3 and choose: || Uninstall - Systems / Standalone Engine / Optional Standalone
Unit 3

Choose Next.

If the installer prompts you to log off from your system, log off and log on again.
The installer restarts automatically.

Follow the instructions on the installer input screens and enter the required parameters.
1 Note
For more information about the input parameters, position the cursor on the parameter and press .
After you have entered all requested input parameters, the installer displays the Parameter Summary

screen. This screen shows both the parameters that you entered and those that the installer set by
default. If required, you can revise the parameters before starting the installation.
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8. To start the installation, choose Start.
The installer starts the installation and displays the progress of the installation.
When the installation option has finished successfully, the installer displays the message Execution of
<Option Name> has completed.

9. We recommend that you delete the directory $userprofile%\.sdtgui.

10. If you copied installation media to your hard disk, you can delete these files when the installation has
successfully completed.

4.3 Additional Information About the Installer

The following sections provide additional information about the installer:

e Useful Information About the Installer [page 29]

e How to Avoid Automatic Logoff by the Installer [page 30]
e |[nterrupted Installation [page 31]

® Performing a Remote Installation [page 33]

e Starting the Installer GUI Separately [page 35]

® Running the Installer with Accessibility Mode [page 37]

e Troubleshooting with the Installer [page 38]

4.3.1 Useful Information About the Installer

This section contains some useful technical background information about the installer and the installer GUI.

e \When you start the installer, it automatically starts the installer GUI.

e The installer creates the installation directory sapinst_instdir, whichis located directly in the
$ProgramFiles$ directory. If the installer is not able to create sapinst instdir there, it tries to create
sapinst_instdir inthe directory defined by the environment variable TEMP.

= Recommendation

We recommend that you keep all installation directories until the system is completely and correctly
installed.

e Foreach installation option, the installer creates a subdirectory located in the sapinst instdir
directory.

e The installer extracts itself to a temporary directory called sapinst exe.xxxxxx.xxxx, which is located
in $TEMP%, $TMP%, $TMPDIR%, Or $SystemRoot%. These files are deleted after the installer has stopped
running.

The temporary directory sapinst exe.xxxxxx.xxxx sometimes remains undeleted. You can safely
delete it.

The temporary directory also contains the log file dev_selfex.out from the extraction process, which
might be useful if an error occurs.
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Caution

If the installer cannot find a temporary directory, the installation terminates with the error Fc0-00058.

® Tosee alist of all available installer properties, open a command prompt and start the installer with
command line parameter -p:

sapinst.exe -p

e |fyou need to run the installer in accessibility mode, make sure that you have activated and adjusted
accessibility settings as described in Running the Installer in Accessibility Mode [page 37].

e |[frequired, you can stop the installer by choosing [» SAPinst # Exit Process Jin the installer GUI menu.

1 Note

If you need to terminate the installer, choose || File  Close GUI only 3 in the menu of the Program
Starter window.

e [fyou want to install an SAP system in unattended mode, see SAP Note 2230669#% which describes an
improved procedure using inifile.params.

4.3.2 How to Avoid Automatic Logoff by the Installer

When you install the SAP system, the installation tool checks whether the user account used for the
installation has the required privileges and authorization.

For a domain installation, the account needs to be both a member of the local Administrators group and the
domain Admins group. For a local installation, the account needs to be a member of the local group
Administrators group.

In both cases, the user account must be authorized to do the following:

e Act as part of the operating system
e Adjust memory quotas for a process
® Replace a process level token

If the user account does not have these rights assigned, the installer assigns them and automatically logs the
account off to activate them. To avoid the installer logging the account off, you can set these rights manually
before you start the installation.

Procedure

You perform the following steps to assign these rights to the user account used for the installation.

Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain
administrator rights to a user who belongs to the local Administrators group, make sure that you have
also defined domain administrator rights for this user on domain level.
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1. Windows Server 2012 (R2): Press +[Esc_Jand choose | Administrative Tools » Local Security
Policy .

2. Windows Server 2008 (R2): Choose | Start » Control Panel » Administrative Tools # Local Security
Policy 3.

3. Inthe Local Security Settings window, choose | Local Policies  User Rights Assignment. 3.
4. Double-click the required right under Policy and choose Add User or Group.
5. Inthe Select Users and Groups window, choose the required user and choose Add.

The selected user appears in the box below.

6. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the
installation.

~

Log off and log on again to apply the changes.

More Information

Required User Authorization for Running the Installer [page 16]

4.3.3 Interrupted Processing of the Installer

Use

The processing of the installer might be interrupted for one of the following reasons:

e Anerror occurred during the Define Parameters or Execute phase:
The installer does not abort the installation in error situations. If an error occurs, the installation pauses
and a dialog box appears. The dialog box contains a short description of the choices listed in the table
below as well as a path to a log file that contains detailed information about the error.

® You interrupted the installation by choosing Exit Process in the SAPinst menu.

Caution

If you stop an option in the Execute phase, any system or component installed by this option is
incomplete and not ready to be used. Any system or component uninstalled by this option is not
completely uninstalled.
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The following table describes the options in the dialog box:

Table 14:
Option Definition
Retry The installer retries the installation from the point of failure without repeating any of
the previous steps.
This is possible because the installer records the installation progress in the
keydb.xml file.
We recommend that you view the entries in the log files, try to solve the problem,
and then choose Retry.
If the same or a different error occurs, the installer displays the same dialog box
again.
Stop The installer stops the installation, closing the dialog box, the installer GUI, and the
GUI server.
The installer records the installation progress in the keydb . xm1 file. Therefore, you
can continue the installation from the point of failure without repeating any of the
previous steps (see the procedure below).
Continue The installer continues the installation from the current point.
View Log Access installation log files.
Procedure

This procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to
continue an interrupted installation after an error.

1. Logonto theinstallation host as a user with the required permissions as described in Running the Installer
[page 27].

2. Make sure that the installation media are still available on the installation host.
For more information, see Preparing the Installation Media [page 22].

= Recommendation

Make the installation media locally available. For example, if you use remote file shares on other
Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from
media mounted with NFS might fail.

3. Restart the installer by double-clicking sapinst.exe from the directory to which you unpacked the
Software Provisioning Manager archive.

1 Note

For more information about how to start the installer, see Running the Installer [page 27] or Performing
a Remote Installation [page 33] and Starting the Installer GUI Separately [page 35].
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4. From the tree structure on the Welcome screen, select the installation option that you want to continue
and choose Next.
The What do you want to do? screen appears.

5. Onthe What do you want to do? screen, decide between the following alternatives and continue with Next:
Table 15:

Alternative Behavior

Run a new option The installer does not continue the interrupted installation option. Instead, it
moves the content of the old installation directory and all installation-specific files
to a backup directory. Afterwards, you can no longer continue the old installation
option.

The following naming convention is used for the backup directory:

log <Day> <Month> <Year> <Hours> <Minutes> <Seconds>

Example

log 01 Oct 2008 13 47 56

Caution

The installer moves all the files and folders to a new log directory, even if these
files and folders are owned by other users. If there are any processes currently
running on these files and folders, they might no longer function properly.

Continue with the old option The installer continues the interrupted installation option from the point of failure.

4.3.4 Performing a Remote Installation

You use this procedure to install your SAP system on a remote host. In this case, the installer runs on the
remote host, and the installer GUI runs on the local host. The local host is the host from which you control the
installation with the installer GUI. The installer GUI connects using a secure SSL connection to the installer.

If your security policy requires that the person performing the installation by running the installer GUI on the
local host is not allowed to know administrator credentials on the remote host, you can specify another
operating system user for authentication purposes. You do this using the SAPINST REMOTE ACCESS_USER
parameter when starting the sapinst.exe from the command line. You have to confirm that the user is a
trusted one. For more information, see SAP Note 1745524 ¥ .

Prerequisites

e Both computers are in the same network and can ping each other.
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To test this:

1. Logonto your remote host and enter the command ping <Local_ Host>.

2. Logonto the local host and enter the command ping <Remote_Host>.

Make sure that the sapinst.exe on the remote host and the sapinstgui .exe on the local host have
exactly the same version. You can check this by using the option -sfxver as described in the procedure
below and in the procedure in Starting the Installer GUI Separately [page 35].

If you need to specify another operating system user with the SAPINST REMOTE ACCESS USER
command line parameter, make sure that this user exists on the remote host.

Procedure

Log on to your remote host as a user that has the required authorization for running the installer [page 16].

Make the installation media available on your remote host.
For more information, see Preparing the Installation Media [page 22].

Open a command prompt and change to the directory to which you unpacked the archive
SWPM10SP<Support Package Number> <Version_ Number>.SAR

Check the version of the sapinst executable by entering the following command:

sapinst -sfxver

The version of the sapinst executable must be exactly the same as the version of the sapinstgui
executable on the local host (see also Starting the Installer GUI Separately [page 35]).

Execute sapinst.exe -nogui

1 Note

If you need to specify another operating system user for authentication purposes, enter the following
command:

sapinst.exe -nogui SAPINST REMOTE ACCESS_ USER=<Specified_ OS User>

1 Note

If you want to use a virtual host name, open a command prompt or PowerShell window in elevated
mode and change to the directory to which you unpacked the file
70SWPM10SP<Support_ Package Number> <Version Number>.SAR

Start the installer with the following command:
sapinst.exe -nogui SAPINST USE HOSTNAME=<Virtual Host Name> (ina command prompt)
.\sapinst.exe -nogui SAPINST USE HOSTNAME=<Virtual Host Name> (in PowerShell)
For more information, see Using Virtual Host Names [page 22].
The installer now starts and waits for the connection to the installer GUI. You see the following in the
Program Starter window:

guiengine: no GUI connected; waiting for a connection on host <Host Name>, port

<Port Number> to continue with the installation

6. Start the installer GUI on your local host as described in Starting the Installer GUI Separately [page 35].
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4.3.5 Starting the Installer GUI Separately

You use this procedure to start the installer GUI separately.
You need to start the installer GUI separately in the following cases:

e You closed the installer GUI using |} File ¥ Close GUI only 4 from the installer menu while the installer is
still running.

® You want to perform a remote installation, where the installer GUI runs on a different host from the
installer. For more information, see Performing a Remote Installation [page 33].

Prerequisites

e The host on which you want to start the installer GUI meets the prerequisites for starting the installer as
described in Prerequisites for Running the Installer [page 271].

1 Note

If you want to run the installer on a UNIX host, make sure that you meet the prerequisites for the
installer listed in the relevant UNIX guide.

e Make sure that the sapinst.exe onthe remote host and the sapinstgui.exe onthe local host have
exactly the same version. You can check this by using the option -sfxver as described in the procedure
below and in the procedure in Performing a Remote Installation [page 33].

Procedure

In this procedure, the following variables are used: <Remote Host> is the name of the remote host, and
<Port Number Gui Server To Gui Client>isthe portthe GUIserver usesto communicate with the GUI
client (21212 by default).

1 Note

If you want to run the installer GUI on a remote host, it is mandatory to start the installer using the -nogui
property. If you have already started the installer without the -nogui property and want to run the GUl on a
different host, you have to exit the installation process by choosing ¢ SAPinst #» Exit Process J and then
follow the steps described in Interrupted Installation [page 31]. Use the -nogui property to restart the
installer and start the installer GUI on the intended host.

Starting the Installer GUI on Windows

1. Make the installer software available on the host on which you want to start the installer GUI.
For more information, see Preparing the Installation Media [page 22].
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2. Startthe installer GUI by executing <Drive>:\<Path_To Unpack Directory>\sapinstgui.exe with
the appropriate command line parameters:
o If you want to perform a remote installation, proceed as follows:

1. Check the version of sapinstgui .exe by entering the following command:
sapinstgui.exe -sfxver
The version of the sapinstgui executable must be exactly the same as the version of the
sapinst executable on the remote host (see also Performing a Remote Installation [page 33]).

2. Start the installer GUI by entering the following command:
sapinstgui.exe -host <Remote_Host> -port
<Port_ Number Gui_Server To_ Gui_Client>

o Ifyou closed the installer GUI using |# File » Close GUI only 3 and want to reconnect to the installer,
proceed as follows:

o If you are performing a local installation with the installer and the installer GUI running on the
same host, execute the following command:
sapinstgui.exe -port <Port Number Gui_Server To Gui_Client>

o If you are performing a remote installation with the installer and the installer GUI running on
different hosts, execute the following command:
sapinstgui.exe -host <Remote_Host> -port
<Port Number Gui_Server To Gui_Client>

3. Theinstaller GUI starts and connects to the installer.

Starting the Installer GUI on UNIX

1. Make the installer software available on the host on which you want to start the installer GUI.
For more information, see Preparing the Installation Media [page 22].
2. Startthe sapinstgui executable with the appropriate command line parameters:
o If you want to perform a remote installation, proceed as follows:
1. Check the version of the sapinstgui executable by entering the following command:
<Path_To_Unpack Directory>/sapinstgui -sfxver
The version of the sapinstgui executable must be exactly the same as the version of the
sapinst executable on the remote host (see also Performing a Remote Installation [page 33]).
2. Start the installer GUI by entering the following command:
<Path_To_Unpack Directory>/sapinstgui -host <Remote Host> -port
<Port_ Number Gui_Server To_ Gui_Client>

o Ifyou closed the installer GUI using ||» File » Close GUI only 3 and want to reconnect to the installer,

proceed as follows:

o If you are performing a local installation with the installer and the installer GUI running on the
same host, execute the following command:
<Path_To_Unpack Directory>/sapinstgui -port
<Port_ Number Gui_Server To_ Gui_Client>

o If you are performing a remote installation with the installer and the installer GUI running on
different hosts, execute the following command:
<Path_To_Unpack Directory>/sapinstgui -host <Remote Host> -port
<Port_ Number Gui_Server To_ Gui_Client>

3. Theinstaller GUI starts and connects to the installer.
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4.3.6 Running the Installer in Accessibility Mode

Use

You can also run the installer in accessibility mode. The following features are available:

e Keyboard access:
This feature is generally available for all operating systems.

e High-contrast color:
This feature is derived from the Windows display properties. You can use it either for a local installation or
for a remote installation.

e Custom font setting:
This feature is derived from the Windows display properties. You can use it either for a local installation or

for aremote installation.

Procedure

Activating and Adjusting Accessibility Settings on Windows

You first have to activate and adjust the relevant settings for the font size and color schemes before you start
the installer or the installer GUI.

1 Note

The following procedure applies for Windows Server 2012 and might be different when using another
Windows operating system.

1. Right click on your Windows desktop and choose Personalize.

2. Select Adjust font size (DPI) and choose Larger scale (120 DPI).
To define other font size schemes, choose Custom DPI.

3. Inthe right-hand pane, select Window Color and Appearance.
Select a color scheme from the Color scheme drop-down box.
To define your own color schemes, choose Advanced.

Running the Installer in Accessibility Mode

You can either perform a local installation, where the installer and the installer GUI are running on the same
host, or a remote installation, where the installer and the installer GUI are running on different hosts.

® | ocal installation:
Start the installer as described in Running the Installer [page 27] by executing the following command:
sapinst.exe -accessible
e Remote installation:
1. Start the installer on the remote host by executing the following command from the command line as
described in Performing a Remote Installation [page 33]:
sapinst.exe -nogui
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2. Start the installer GUI on the local host by executing the following command from the command line
as described in Starting the Installer GUI Separately [page 35]:
sapinstgui.exe -accessible -host <Remote_Host> -port
<Port_ Number Gui_Server To_ Gui_Client>

4.3.7 Troubleshooting with the Installer

This section tells you how to proceed when errors occur during the processing of the installer.

If an error occurs, the installer does one of the following:

It stops processing
It displays a dialog informing you about the error

Procedure
1. Check SAP Note 1548438#% for known installer issues.
2. Toview the log file, choose View Logs.
3. Ifanerror occurs during the Define Parameters or Execute phase, do one of the following:
o Tryto solve the problem
o Stop the installer by choosing Stop from the error message or |# SAPinst » Exit Process Jin the tool
menu.
For more information, see Interrupted Installation [page 31].
After resolving the problem, you can continue the processing of the installer by choosing Retry.
4. Check the log and trace files of the GUI server and the installer GUI in the directory $userprofile%
\.sdtgui) forerrors.
o Ifthe installer GUIl does not start, check the file sdtstart.errinthe current Suserprofile?
directory.
5. If you cannot resolve the problem, create a customer message using component BC-INS.
For more information about using subcomponents of BC-INS, see SAP Note 1669327 #ir .
Installation of a Standalone SAP Gateway Instance for SAP Systems Based on SAP
NetWeaver 7.0 to 7.03 onWindows
38 CUSTOMER

Installation


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1548438
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1669327

5 Post-Installation Activities

5.1 SAP Gateway Configuration

You have to configure SAP Gateway to be able to use it.

You find the configuration documentation in the SAP Library [page 8] at: |* Application Platform by Key
Capability ¥ Platform-Wide Services » Connectivity » SAP Gateway J
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6 Additional Information

6.1 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide
their physical network identities from each other. This can be useful when quickly moving SAP servers or
complete server landscapes to alternative hardware without having to reinstall or reconfigure.

Prerequisites

e Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.
e Make sure that you configured the Windows operating system properly to use virtual host names. For
more information, see SAP Note 1564275 .

Procedure

To install a non-high-availability system using virtual host names, proceed as described in SAP Note 1564275

i

6.2 Checking and Changing the Paging File Settings on
Windows Server 2012 (R2)

Use

This section describes how to check and change the paging file size on Windows Server 2012 (R2) with
PowerShell.

The PowerShell commands also work in previous Windows versions where PowerShell is available.

1 Note

Some paging file operations require a reboot of the server to activate the changes you made. Wmi-
commands do not indicate whether a reboot is required or not. Therefore, we recommend rebooting your
system every time you change the paging file settings with PowerShell.
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Prerequisites

Always start the PowerShell in elevated mode (run as administrator).

Procedure

Checking the Size of a Paging File

1. Start Windows PowerShell.
2. Check whether the default value Automatic manage pagefile size for all devices is activated.

1 Note

We do not support automatically managed page file sizes.

To check this, enter the following command:
(Get-WmiObject Win32_ Pagefile) -eq $null
If Automatic manage pagefile size for all devices is enabled, the output value is True.
If necessary, disable Automatic manage pagefile size for all devices with the following command:
$sys = Get-WmiObject Win32 Computersystem -EnableAllPrivileges
$sys.AutomaticManagedPagefile = $false
$sys.put()
3. Check the size of the paging files with the following command:
Get-WmiObject WIN32 Pagefile | Select-Object Name, InitialSize, MaximumSize,
FileSize
The output looks like the following:

Name InitialSize
MaximumSize FileSize

C:\pagefile.sys 0 0
41943040000

E:\pagefile.sys 40000 80000
41943040000

In this example, in the first line, the InitialSize and MaximumSize values of a paging file are O, which means
that the paging file size is system managed (not recommended).
In the second line, the paging file size has a minimum and a maximum size (recommended).

Changing the Size of a Single Paging File

Changing the InitialSize and MaximumSize values of a paging file to a size other than O, will automatically
switch off system managed size.

In the following example, we change the size of the paging file on C: to the InitialSize of 40 GB and to the
MaximumSize of 80 GB.

Use the following commands in a PowerShell:

$Pagefile = Get-WmiObject Win32_ PagefileSetting | Where-Object {$_.name -eq “C:
\pagefile.sys”}
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$Pagefile.InitialSize = 40000

$Pagefile.MaximumSize 80000
$Pagefile.put()

Typically, you choose the same value for InitialSize and MaximumSize.

1 Note
The sum of all paging files InitialSize values must be equal to or higher than the value recommended for
your SAP system.
Creating a Second Paging File on Another Disk

You might want to create a second or additional paging files to improve system performance, or if your disk
does not have enough space.

To do so, enter the following commands in a PowerShell:
$Pagefile = Get-WmiObject Win32_PagefileSetting
$pagefile.Name = “E:\pagefile.sys”
$pagefile.Caption = “E:\pagefile.sys”
$pagefile.Description = “/'pagefile.sys’ Q@ E:\”
$pagefile.SettingID ="pagefile.sys Q@ E:”
$pagefile.InitialSize = 80000
$pagefile.MaximumSize = 80000

$pagefile.put()

Deleting a Paging File on a Specific Device

To delete a paging file, enter the following commands in a PowerShell:

Spagefile = Get-WmiObject Win32_ PagefileSetting | Where-Object {$_.name -eq “E:
\pagefile.sys”}

Spagefile.delete ()

6.3 Starting and Stopping the Instance

Use

You have to check that you can start and stop the Gateway instance after the installation using the SAP
Microsoft Management Console (SAP MMC).
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Procedure

1. Logonasuser <sapsid>adm.

2. Start the SAP MMC by choosing | Start » Programs #» SAP Management Console 3.
3. Right-click the icon of the standalone Gateway system under the SAP systems node and choose Start or
Stop.

More Information

For more information about the SAP MMC, see the SAP Library [page 8] at:

|» Solution Life Cycle Management by Key Capability » Solution Monitoring # Monitoring in the CCMS » SAP

Microsoft Management Console: Windows 3

6.4 Uninstalling the Instance

Use

The following procedure describes how to uninstall a standalone Gateway instance using the installer.

Procedure

1. Start theinstaller [page 27].
2. Onthe Welcome screen, choose | Software Life-Cycle Options » Uninstall System / Standalone Engine /

Optional Standalone Unit .
3. Follow the instructions in the installer screens.

1 Note

To find more information on each parameter during the Define Parameters phase of uninstalling,
position the cursor on the field of the respective parameter and press .
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be
a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however,
does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations
of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as
"sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun
does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does
not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any
damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for
transparency (see: http://help.sap.com/disclaimer).

Open Source Software and Third Party Components

Please refer to https://scn.sap.com/docs/DOC-42044 for information respecting open source software components made available by SAP as part of SAP
NetWeaver and any specific conditions that apply to your use of such open source software components. Please refer to https://scn.sap.com/docs/DOC-42045 for
information relating to SAP’s use of third party software with or within SAP NetWeaver.
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